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Questions and Answers 
 
This document addresses common questions 
about Autodesk Ecotect Analysis software’s 
technical capabilities and design process. 
 

Contents 
1. General Product Information ....................................................................................... 3 

1.1 What is Autodesk Ecotect Analysis? .................................................................. 3 

1.2 How do I access the web-based capabilities? .................................................... 3 

1.3 When do I use the desktop tools in Ecotect Analysis versus web-based 
capabilities? .............................................................................................................. 3 

1.4 Can I use Autodesk Ecotect Analysis with a 2D AutoCAD® file? ........................ 4 

1.5 Will I get better results if I conduct the analysis once the detailed design is 
complete? ................................................................................................................. 4 

1.6 Does Autodesk Ecotect Analysis only analyze commercial buildings? ............... 4 

1.7  Is Autodesk Ecotect Analysis only suited for new construction projects? .......... 4 

2. Whole Building Analysis .............................................................................................. 4 

2.1 What capabilities does the web-based technology provide? .............................. 4 

2.2 What is green building extensible markup language (gbXML)? .......................... 5 

2.3 How does Autodesk Ecotect Analysis choose the material assemblies, 
schedules, and so on, required for whole-building energy analysis? ........................ 5 

2.4 Can I import design changes I make in the web-based service back to my 
design software and building model? ....................................................................... 5 

3.0 Detailed Visualization and Simulation ...................................................................... 5 

3.1 Can I use zones like layers in AutoCAD? ........................................................... 5 

3.2 When I import a DXF™ model into Ecotect Analysis, is there a way to avoid all 
the geometry coming in as triangles? ....................................................................... 5 

3.3 Why do some objects in my model turn red? ...................................................... 6 

3.4 Can I add or modify materials in Autodesk Ecotect Analysis? ............................ 6 

3.5 What is the difference between Primary and Alternate material assignments? .. 6 

3.6 Why do I have to run inter-zonal adjacency calculations? .................................. 7 

3.7 How do I interactively move the sun position? .................................................... 7 



AUTODESK ECOTECT ANALYSIS 2010 QUESTIONS AND ANSWERS 

2 

3.8 What engine or algorithm does Autodesk Ecotect Analysis use to do thermal 
analysis? .................................................................................................................. 7 

3.9 How do I cut a 3D section through my model? ................................................... 7 

3.10 Can I save animations as I move around the model in Ecotect? ...................... 8 

3. Consulting, Training, and Support.............................................................................. 8 

3.1 Where can I find other resources to help me learn more about using Autodesk 
Ecotect Analysis 2010? ............................................................................................ 8 

4. Subscription ................................................................................................................. 8 

4.1 What other benefits does an Autodesk Ecotect Analysis 2010 software 
subscription offer? .................................................................................................... 8 



AUTODESK ECOTECT ANALYSIS 2010 QUESTIONS AND ANSWERS 

3 

1. General Product Information 
1.1 What is Autodesk Ecotect Analysis?  
Autodesk Ecotect Analysis 2010 software is a comprehensive, concept-to-detail 
sustainable design analysis tool, providing a wide range of simulation and analysis 
functionality through desktop and web-service1 platforms. Users can interact with powerful 
3D feedback to explore factors such as solar, shadows and reflections, and daylighting. 
Customers who add subscription to Autodesk Ecotect Analysis can access the web-based 
technology from Autodesk Green Building Studio to quickly evaluate multiple design 
alternatives for energy and water efficiency and carbon neutrality. Using Autodesk Ecotect 
Analysis, architects and designers can gain better insight into building performance early 
in the process, helping to achieve more sustainable designs, faster time to market, and 
lower project costs. 

1.2 How do I access the web-based capabilities? 
Customers who add subscription to their Autodesk Ecotect Analysis license can access 
the web-based service for the duration of their subscription. Ask your reseller to add 
subscription to your purchase. Once your Autodesk Green Building Studio account is set 
up, you (or your software coordinator) will receive an email with your account information 
(user name and temporary password) and instructions on getting started. 

1.3 When do I use the desktop tools in Ecotect Analysis versus web-based 
capabilities? 
Autodesk Ecotect Analysis provides you with a comprehensive solution for sustainable 
design analysis in one platform. Use the desktop tools and web-service functionality 
together to create more sustainable designs. Here is an example of how the tools are 
complementary: At the start of the design process, early-stage, massing models can be 
used in combination with the site analysis functionality in the desktop tools to determine 
the optimal location, shape, and orientation of a building design based on fundamental 
environmental factors such as daylight, overshadowing, solar access, and visual impact.  

As the conceptual design evolves, whole-building energy solutions available via the web 
service  can be used to benchmark its energy use and show areas of potential savings. 
Once these fundamental design parameters have been established, use the desktop tools  
to rearrange rooms and zones, to size and shape individual openings, to design custom 
shading devices, or to choose specific materials based on environmental factors such as 
daylight availability, glare protection, outside views, and acoustic comfort.  

                                                           

 

 

 

 

 
1 Customers who add subscription to their Autodesk Ecotect Analysis license can access whole building 
analysis capabilities via the Autodesk® Green Building Studio® web‐based service for the duration of their 
subscription, subject to the terms of use that accompanies the service.    
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1.4 Can I use Autodesk Ecotect Analysis with a 2D AutoCAD® file?    
The intelligent objects in the building information model enable the advanced analysis and 
simulation functionality in Autodesk Ecotect Analysis. The information required to conduct 
the analysis would need to be manually calculated from 2D drawings, using building 
plans, elevations, and details to collate spaces (type, area, volume), surfaces (including 
adjacency and thermal properties), and shading. All this information is latent in a building 
information model, and in a form that is much easier to interpret than 2D drawings. The 
net result is a time-intensive task that might only be done once, very late in the design 
process. Building information modeling (BIM) is core to Autodesk’s sustainable design 
approach for building performance analysis and simulation. Developing and evaluating 
multiple alternatives at the same time enables easy comparison and helps inform better 
sustainable design decisions.  

1.5 Will I get better results if I conduct the analysis once the detailed design is 
complete? 
As soon as the layout of a building’s walls, windows, roofs, floors, and interior partitions 
(elements that define a building’s thermal zones) are established, a model is ready for 
whole-building analyses. Detailed designs require time to create, will take longer to run 
through the analysis, and will not produce significantly more detailed results. For most 
building projects, decisions made in the first few weeks of the design end up having the 
greatest impact on a building’s performance—the location of the building on the site, its 
basic form and orientation, its internal layout and external materials selection, its exterior 
openings. By conducting analysis earlier in the schematic phase, you will have more 
opportunities to study alternative design concepts for optimal sustainability, before many 
of these factors have been finalized.   

1.6 Does Autodesk Ecotect Analysis only analyze commercial buildings? 
Autodesk Ecotect Analysis can be used to analyze residential, commercial, and institutional 
project types.  

1.7  Is Autodesk Ecotect Analysis only suited for new construction projects? 
Existing buildings can also be analyzed using Autodesk Ecotect Analysis, provided that there 
is a building information model to submit that approximates the building’s geometry.  

 
 

 

2. Whole Building Analysis 
2.1 What capabilities does the web-based technology provide? 
Autodesk Ecotect Analysis enables whole building analysis through the Green Building 
Studio web-based technology. Customers who add subscription to their Autodesk Ecotect 
Analysis license get access to the web-service’s industry-leading building energy and 
carbon analysis tools. The web service provides a user-friendly front end to some of the 
world’s most powerful building energy analysis software. All of the computationally 
intensive hourly simulations are carried out on remote servers, and the results are 
provided to you in a web browser.   
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2.2 What is green building extensible markup language (gbXML)? 
The green building extensible markup language (gbXML) is an open, non-proprietary 
schema that was developed to facilitate intelligent information exchange, enabling 
integrated interoperability between building design models and a wide variety of 
engineering analysis tools available today. Autodesk Green Building Studio relies on the 
gbXML file format to securely transfer building information between design tools such as 
Autodesk® Revit® Architecture and its web-based whole-building energy analysis engine, 
DOE-2.  

2.3 How does Autodesk Ecotect Analysis choose the material assemblies, 
schedules, and so on, required for whole-building energy analysis? 
The appropriate defaults are based on where your building is located, the building type, and 
the size of your building. The majority of construction, schedule, and equipment defaults are 
ASHRAE 90.1-2004 compliant.  

2.4 Can I import design changes I make in the web-based service back to my design 
software and building model? 
Changes made on the Green Building Studio web servicecannot be automatically incorporated 
back into the building information model, as the software is not yet designed to accept gbXML 
input files.   

 

3.0 Detailed Visualization and 
Simulation   
3.1 Can I use zones like layers in AutoCAD? 
When you are doing thermal and acoustic calculations in Ecotect Analysis, zoning is very 
important as you can set a zone to thermal, meaning that it represents an enclosed 
volume of relatively homogeneous air. Each thermal zone therefore needs to define a 
room, essentially, with a complete envelope of enclosing surfaces. This way, inter-zonal 
heat flow paths and incident radiation collection can be automatically determined and will 
have effects on the right air volumes.   

In lighting and shadow calculations, zones are not as important. However, if you wish to 
compare light levels in different rooms you will still need to organize your “layers” based 
on zone definitions. It is usually best practice to use a thermal zone for each room and 
then add any external or extraneous geometry to additional non-thermal zones. This way 
you can use the same model for all types of calculation, with all the essential thermal and 
acoustic geometry in room-based zones but with detailed window frames, skirting boards, 
furniture, and the like in separate non-thermal zones that can be turned off when not 
required. 

3.2 When I import a DXF™ model into Ecotect Analysis, is there a way to avoid all 
the geometry coming in as triangles? 
Simply select all the triangulated geometry and from the Modify menu choose the Merge 
Coincident Triangles item. The program will then determine if the faces exist on the same 
plane and have coincident nodes, and then merges them together into a more complex 
polygon. 
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3.3 Why do some objects in my model turn red? 
To make editing and object manipulation faster and more intuitive, Autodesk Ecotect 
Analysis uses a series of inter-object relationships. This way a ceiling knows that it must 
reflect the shape of the floor from which it was created, a window knows it belongs inside 
a wall surface, the nodes in a planar object know they must all remain in the same 
mathematical plane and so on. Sometimes your model can violate one or more of these 
relationships. For example, snapping one node in a wall to the other side of the room or 
reducing the size of a wall such that its window can no longer fit within it. Objects that 
violate their relationships are shown in the error color, the default for which is red. 

To attempt to fix any bad links, simply select Fix Links from the Edit menu. If the object 
keeps turning red, or fixing its links results in unwanted changes to your model, you can 
simply unlink it by selecting Unlink, also in the Edit menu. Some links are necessary (such 
as the link between a wall and a window, otherwise they are just two objects that share 
the same plane), whereas most are simply there to make editing the model a little simpler 
and easier. If certain links are getting in the way, just unlink the objects. You can always 
edit them individually later. 

Another reason for red objects can be because they are non-planar (that is, an object with 
more than three nodes has one node that does not sit within the same flat plane as the 
other three nodes). Or perhaps the red object is a child object that is not completely 
contained within its parent object. Either way, the Fix Links command has options for 
trying to correct these situations. 

3.4 Can I add or modify materials in Autodesk Ecotect Analysis? 
The material library is completely customizable, so you can add new materials, delete 
existing ones or change any property at any time. You can also load and save any 
number of customized libraries for your office or for sharing with other users. 

Autodesk Ecotect Analysis stores material information in both centralized library files as 
well as within each model itself. Thus, if you create your own customized materials for a 
particular job and then email the model to someone else, all of the model materials will still 
be available to them. The use of central libraries also makes transferring materials 
between models very simple and easy. 

3.5 What is the difference between Primary and Alternate material assignments? 
One of the fundamental features of an Autodesk Ecotect Analysis model is the ability to 
drag objects around or rearrange zones. When two zones are positioned adjacent to or on 
top of each other, there will be some portion of their external envelope that will overlap the 
envelope of an adjacent zone. In normal building construction it is unlikely that the same 
building material will be used in the overlapping and non-overlapping sections. 

When you create a new object, it is automatically assigned a primary and alternate 
material, being the material you have set as the default for that object’s element type. 
Initially the alternate material is the same as the primary material. Defining a different 
alternate material allows you to move zones around as much as you want without 
worrying about what parts of the wall are external cavity-brick, for example, and how much 
will be internal single-brick. As the software automatically determines what portion of any 
surface overlaps any other, the alternate material is used in place of the primary material 
in these areas when the element is a void, roof, floor, ceiling or wall. 

When editing windows, doors, panels, voids, lights, or speakers, the alternate material has 
a slightly different meaning. Each such object can be assigned an activation and 
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deactivation time. During the activated period, the alternate material replaces the default 
material. This can be used to simulate the opening and closing of blinds or the switching 
on of appliances, and so on. 

3.6 Why do I have to run inter-zonal adjacency calculations? 
The inter-zonal adjacencies calculation is done to work out what model surfaces overlap 
between zones and to generate and cache the solar shading masks of all objects on 
thermal zones. This information is needed by thermal, acoustic, and large-scale solar 
shadowing calculations. It is large-scale because the insulation on selected surfaces in 
the Graphical Results dialog is calculated in real time (it is only a few objects for a set time 
period) whereas the cumulative insulation calculation displayed over the whole building 
needs to cache masks because you may want to run it over many thousands of surfaces 
and then for lots of different time periods. 

Basically the general rule is, if you change the geometry you will need to run an inter-
zonal calculation before your next thermal or acoustic analysis. Now that is not when you 
assign a different material, it is when you physically alter the model geometry. Typically, 
the software will determine when an inter-zonal calculation needs to be done and will 
prompt you as such. 

3.7 How do I interactively move the sun position? 
You can move the sun a number of ways: 

• By setting the date and time in the Shadow Settings panel. 
• Using the PageUp and PageDown keys when the focus is set to either the date 

or time edits. This changes the time in 15-minute increments or the date in 
weeks. Holding the Shift key down at the same time changes by one hour/month 
while the Control key changes by one minute/day. 

• By selecting and dragging the sun interactively with the mouse when the 3D sun-
path is displayed. A small red node should be visible in the centre of the sun. If 
you hold down the Shift key, you can interactively change the date instead. 
Holding down the Control key interactively updates the shadows as you drag. 

3.8 What engine or algorithm does Autodesk Ecotect Analysis use to do thermal 
analysis? 
Autodesk Ecotect Analysis uses the Chartered Institute of Building Services Engineers 
(CIBSE) Admittance method for its internal thermal calculations. This is an internationally 
regarded method used by building services engineers and designers  The software can 
also export to a range of other thermal analysis tools such as the Autodesk Green 
Building Studio web-based service, EnergyPlus, HTB2, and ESP-r. This allows you to 
consider a design using a range of different methods, including Autodesk Ecotect Analysis 
software’s own internal calculations with the admittance method. 

3.9 How do I cut a 3D section through my model? 
The section cut is only available in the Visualize page, whose tab is located on the left-
hand of the main application windows. If you then click on the Visualization Settings panel 
and scroll most of the way down, you should come across a heading labeled Section 
Plane containing a check box and slider. If you check this feature then slide the slider, you 
should see the red section cut lines cut through your model. 

The section cutting plane is based on the Autodesk Ecotect Analysis model grid and will 
only slide within the extents of this grid and is limited to the XYZ planes of the grid. With 
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regard to the shadow casting, this will work as normal in the Visualize page and at the 
same time as the section cut, as long as you have both on at the same time. 

3.10 Can I save animations as I move around the model in Ecotect? 
Yes. The first step is to choose Create Animation… from the Tools menu to display the 
settings for the animation itself, the part of the window to use and the method to capture 
images. Once you start the animation, you can use the controls at the top of the Display 
Settings panel to pause, add additional frames, stop, and play back your newly created 
video. 

 

3. Consulting, Training, and Support 
3.1 Where can I find other resources to help me learn more about using Autodesk 
Ecotect Analysis 2010? 
For a list of technical support resources for Autodesk Ecotect software, visit the Support 
section of the Autodesk Ecotect product center at www.autodesk.com/ecotect; visit one 
of our discussion groups at www.autodesk.com/discussion; or check with your local 
Autodesk Authorized Reseller for a schedule of software training classes. To locate a 
reseller, visit www.autodesk.com/reseller.  

4. Subscription 
4.1 What other benefits does an Autodesk Ecotect Analysis 2010 software 
subscription offer? 
When you add Autodesk® Subscription to your Autodesk Ecotect Analysis sustainable 
design software purchase, you get the benefits of increased productivity, predictable 
budgeting, and flexible license management. Subscribers of Autodesk Ecotect Analysis 
get any new upgrades of your Autodesk software and any incremental product 
enhancements, if these are released during your subscription term, , and exclusive license 
terms that are available only to Subscription members. A range of community resources, 
including web support direct from Autodesk product support specialists and self-paced 
training to extend your skills, make Autodesk Subscription the best way to optimize your 
investment in Autodesk Ecotect Analysis 2010 software.  

To learn more, take the Subscription tour at www.autodesk.com/subscription. 
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